
Comments and Upgrades
Comments and Suggestions
If you have comments, questions or find any bugs in Screen Loupe for Windows 95/NT please feel free to contact me on 
CompuServe or America Online.

Upgrade Notification
If you would like to be notified when this application is upgraded send me an email message with your online address. Please 
include the version number of Screen Loupe that you are using and the location that you downloaded my software from.    I will 
email you when a new version of Screen Loupe for Windows 95/NT is uploaded to my web site on the Internet, CompuServe, 
America Online, ExecPC, ZD Net, and MSN.

Gregory Braun
CompuServe: 71613,2175
AOL: GreggBraun
Email: 71613.2175@compuserve.com
Web Site: http://www.execpc.com/~sbd
Phone: 1.414.444.8497

Contributions
While Screen Loupe is offered as Freeware, if you would like to pay for it you are welcome to send any amount you wish to:

Gregory Braun
5609 West Hadley Street
Milwaukee, WI 53210-1554    USA

Your contributions are always welcome, and encourage me to continue developing new applications.

Web Site
Visit my web site on the Internet to download the latest versions of all of my freeware offerings.

Software by Design Web Site

(http://www.execpc.com/~sbd)



Software by Design Web Site
Software by Design
You can download the latest versions of all of my freeware from my web site on the Internet. I post the latest releases of my 
software there first. Click your mouse on the link listed below to visit the Software by Design web site.

Software by Design Web Site

(http://www.execpc.com/~sbd)

Freeware Titles
The following software titles are available at my web site on the Internet and can also be found on CompuServe, America 
Online, ExecPC, MSN and ZD Net.

NoteBook for Windows (NBOOK.ZIP)
NoteBook for Windows 95/NT (NBOOK32.ZIP)
Reminders for Windows (REMIND.ZIP)
Reminders for Windows 95/NT (REMIND32.ZIP)
ToolBar for Windows (TBAR.ZIP)
ToolBar for Windows 95/NT (TBAR32.ZIP)
Screen Loupe for Windows (LOUPE.ZIP)
Screen Loupe for Windows 95/NT (LOUPE32.ZIP)
Screen Loupe for Macintosh (LOUPE.SEA)
Audition for Windows 95/NT (AUDITION.ZIP)
Password Keeper for Windows 95/NT (PASSKEEP.ZIP)
CardBase for Windows 95/NT (CARDBASE.ZIP)
File Editor for Windows (FXEDIT.ZIP)
File Editor for Windows 95/NT (FXEDIT32.ZIP)
Crypto for Windows 95/NT (CRYPTO.ZIP)
Icon Extractor for Windows (ICONX.ZIP)
Icon Extractor for Windows 95/NT (ICONX32.ZIP)
FontShow for Windows 95/NT (FONTSHOW.ZIP)
TxEdit for Windows 95/NT (TXEDIT.ZIP)
DLL Show for Windows 95 (DLLSHOW.ZIP)
RGB Editor for Windows (RGB.ZIP)
RGB Editor for Windows 95/NT (RGB32.ZIP)
Quiz Wizard for Windows 95/NT (QUIZWIZ.ZIP)
Programmer's IDE (PMAN.ZIP)
Programmer's IDE 95/NT (PMAN32.ZIP)
Touch for Windows (WTOUCH.ZIP)
Disk CleanUp for Windows 95/NT (CLEANUP.ZIP)
BattleStar for Windows (BSTAR.ZIP)
BattleStar for Windows 95/NT (BSTAR32.ZIP)
World Radio for Macintosh (WRADIO.SEA)

Note The latest versions of my software programs are always posted on my web site first. Versions found on the other online 
services may be earlier releases.



BBS and Internet Operators
Webmasters
Please upload the original ZIP file intact and title the submission:

"Screen Loupe for Windows 95/NT v3.4"
--Author Gregory Braun

Web Site
Visit my web site on the Internet to download the latest versions of all of my freeware offerings.

Software by Design Web Site

(http://www.execpc.com/~sbd)

Note This site also supports anonymous FTP transfers.





Screen Loupe for Windows 95/NT
Copyright © 1991-1997 by Gregory Braun. All rights reserved.

Overview
Screen Loupe displays a magnified view of whatever is beneath the mouse cursor, much like a printer's or jeweler's loupe. As 
you move the mouse about the desktop the Screen Loupe window will display the region currently underneath the mouse at the 
currently selected viewing magnification.

Window Size
Screen Loupe’s main window can be resized. This feature makes it ideal for screen captures. Just size the window to 
accommodate the area you wish to copy and press Ctrl+C.

Tools
Screen Loupe also displays information about the current hardware configuration and dynamic system resource usage as well 
as an ASCII / ANSI character code chart, MS Windows Error Codes and resizable Horizontal and Vertical rulers.

Sight Impairments
Screen Loupe was originally designed to facilitate accurate viewing of graphic images during program development, but many 
people have written to me regarding its use as a screen magnifier for computer users with vision impairments. If you are using 
Screen Loupe as a screen magnifier for this purpose see the section regarding Viewing a Fixed Region.

Desktop Locations
Screen Loupe’s location on the desktop is saved when the program is exited. Whenever you start Screen Loupe it will reappear 
on the desktop where you last placed it. Screen Loupe dialog box locations are also stored and reused the next time they are 
opened.

Taskbar Tray
Screen Loupe for Windows 95/NT can be optionally configured to place its program icon in the Taskbar Icon Notification Tray. 
This option provides a simple means of keeping the taskbar button region clear for other running programs.



Installing Screen Loupe
Installation
To install Screen Loupe for Windows 95/NT on your computer simply create a new, empty folder and place the files; 
LOUPE.EXE, LOUPE.CNT and LOUPE.HLP there.

LOUPE.EXE - The Screen Loupe Application
LOUPE.HLP - The Windows 95/NT Help File
LOUPE.CNT - The Windows 95/NT Help Contents File

To integrate Screen Loupe for Windows 95/NT with the MS Windows Explorer select the Screen Loupe Explorer Setup dialog 
box while Screen Loupe is running.

Note If you have an earlier version of Screen Loupe for Windows 95/NT installed on your computer, simply replace the 
LOUPE.EXE, LOUPE.CNT and LOUPE.HLP files with the newer versions.

Note The LOUPE.INI file is no longer used and can be deleted. The various application settings specified in the Screen Loupe 
Options dialog box as well as the main window’s size and location on the desktop are now stored in the MS Windows 95/NT 
System Registry.

Note Some earlier versions of Screen Loupe for Windows 95/NT included a LOUPE.WRI documentation file. This file has been 
replaced by the LOUPE.HLP file and can now be deleted.

Warning If you rename the LOUPE.EXE file you must also rename the HLP file using the same basename. For example if you 
change the Screen Loupe application file name to NewName.exe, rename the help file to NewName.hlp. The HLP file must 
reside in the same folder as the Screen Loupe application file itself.



Configuring Screen Loupe
Screen Loupe Options
Select the File | Options menu item to display the Screen Loupe Options dialog box. This window will allow you to change the 
various Screen Loupe program settings listed below.

Screen Loupe Window Refresh Rate
Selects a viewing window refresh rate. For most applications the Normal refresh rate will be adequate. If you have a fast 
computer system you may want to select the Fast setting. Use the Slow setting for older systems or when you only need to 
use Screen Loupe for screen capture operations.

Launch Multiple Instances
Check this item to allow more than one instance of Screen Loupe to be run on the desktop.

Place Icon in Taskbar Tray
Check this item to display a small Screen Loupe program icon in the Taskbar Icon Notification Tray. If this item is selected and
the Screen Loupe window is minimized a button will not be added to the Taskbar, to restore the Screen Loupe window on the 
desktop press the small icon in the taskbar tray instead. This option is available to keep the taskbar free for other running 
programs.

Show HTML Color Triplets
Check this item to display the color value directly beneath the mouse cursor as an HTML color triplet. If this item is not 
checked the color of the pixel beneath the mouse cursor will be displayed as a normal RGB hexadecimal value.

Play Shutter Sound when Copying
Check this box to play a SLR camera shutter sound when the Screen Loupe display window is copied to the Clipboard.

Beep when Locking the View
Check this box to issue a warning beep when view locking is turned on and off.

Keep these Windows Topmost on the Desktop
Check these boxes to make the specified child windows topmost on the Desktop. Keeping the Horizontal and Vertical rulers 
topmost will make measurement of desktop objects easier. Making the System Information window topmost will provide a 
simple means of monitoring application launches.

OK
Press this button when you have completed your selection of Screen Loupe program options. When you press this button the 
Screen Loupe Options dialog box will be closed and your settings will be saved.

Cancel
Press this button to close the Screen Loupe Options dialog box without making any changes. If you have made any changes 
to the option settings, and then press this button your changes will not be used, and your previous settings will remain in use.

Help
Press this button to open the Screen Loupe Help Window and go directly to the Configuring Screen Loupe topic.

Note The options you have selected will be saved when you press the OK button. The desktop location of the Screen Loupe 
Options window itself will also be stored. Your settings will be saved in the MS Windows 95/NT System Registry.



Screen Loupe Explorer Setup
Screen Loupe Explorer Setup

Select the Help | Setup menu item to display the Screen Loupe Setup dialog box. This window will allow you to integrate 
Screen Loupe for Windows 95/NT with the Microsoft Windows 95/NT Explorer. Use this command to create and remove MS 
Explorer shortcuts.

Create a Start Menu Item
Check this item to create a Screen Loupe Start Menu entry. The Screen Loupe for Windows 95/NT program will be located in 
the Software by Design folder on the Programs menu. This item will be disabled (grayed) if a Screen Loupe item already 
exists in the Software by Design folder.

Remove this Start Menu Item
Check this item to remove the Screen Loupe entry located in the Software by Design folder on the Programs menu. This item 
will be disabled (grayed) if a Screen Loupe item does not already exist in the Software by Design folder.

Create a Desktop Icon
Check this item to create a Screen Loupe for Windows 95/NT program icon on the Explorer desktop. This item will be disabled
(grayed) if a Screen Loupe desktop icon already exists.

Remove Icon from the Desktop
Check this item to remove the Screen Loupe for Windows 95/NT program icon from the Explorer desktop. This item will be 
disabled (grayed) if a Screen Loupe desktop icon does not already exist.

Create a Startup Folder Item
Check this item to automatically run Screen Loupe for Windows 95/NT whenever Microsoft Windows is started. This option 
creates a Screen Loupe program icon in the MS Windows Explorer Startup folder. This item will be disabled (grayed) if a 
Screen Loupe startup item already exists in the Startup folder.

Remove the Startup Folder Item
Check this item to remove Screen Loupe from the MS Windows Explorer Startup folder. This item will be disabled (grayed) if a
Screen Loupe startup item does not already exist in the Startup folder.

OK
Press this button when you have completed your selection of MS Explorer shortcuts. When you press this button the Screen 
Loupe Setup dialog box will be closed and the MS Explorer shortcuts you have selected will be created or removed.

Cancel
Press this button to close the Screen Loupe Explorer Setup dialog box without creating or removing any MS Explorer 
shortcuts.

Help
Press this button to open the Screen Loupe Help window and go directly to the Screen Loupe Explorer Setup topic.



File Menu
File Menu Commands
The File menu provides commands to configure and exit Screen Loupe. A short description of each item follows:

Options
Opens the Screen Loupe Options dialog box and allows you to change Screen Loupe program settings. Use this command 
to configure the Screen Loupe program.

Exit
Closes the Screen Loupe program and returns control to the Explorer desktop. The Ctrl+Q shortcut can be used for this 
command.

Tip Commonly used File commands can be invoked using shortcut keys.



Edit Menu
Edit Menu Commands
The Edit menu provides commands used to copy the contents of the Screen Loupe window to the Clipboard.

Copy
Copy the current Screen Loupe window’s view to the Clipboard. The Ctrl+C shortcut can be used for this command.

Tip Commonly used Edit commands can be invoked using shortcut keys.



View Menu
View Menu Commands
The View menu provides commands used to change Screen Loupe display options. These items provide a means of changing 
the Screen Loupe window appearance. A short description of each item follows:

Position
Use this command to turn the mouse position region on and off. If this item is checked Screen Loupe will display the current
mouse location in global screen coordinates as well as report the color of the pixel directly beneath the mouse pointer. With
this item checked you will also be able to quickly change the view magnification using the radio buttons displayed at the 
bottom of the view region.

Crosshair
Use this command to turn the viewing crosshair on and off. If this item is checked Screen Loupe will display a small 
crosshair target at the center of the viewing window. Use this command to accurately locate the center of a displayed 
image.

Normal Size
Use this command to set Screen Loupe’s magnification to the normal 1:1 rate. The Ctrl+1 shortcut can be used for this 
command.

2x Zoom
Use this command to set Screen Loupe’s magnification to the 2:1 rate. The Ctrl+2 shortcut can be used for this command. 
Images will appear twice as large as they really are when this magnification rate is selected.

4x Zoom
Use this command to set Screen Loupe’s magnification to the 4:1 rate. The Ctrl+4 shortcut can be used for this command. 
Images will appear four times as large as they really are when this magnification rate is selected.

8x Zoom
Use this command to set Screen Loupe’s magnification to the 8:1 rate. The Ctrl+8 shortcut can be used for this command. 
Images will appear eight times as large as they really are when this magnification rate is selected.

Lock View
Use this command to lock the current view. The Ctrl+K shortcut can be used for this command.

Fixed View
Use this command to view a fixed region of the desktop. The Ctrl+F shortcut can be used for this command.

Minimize
Minimizes the Screen Loupe window to a button or icon on the taskbar. The Ctrl+Y shortcut can be used for this command.

Always on Top
Use this command to keep the Screen Loupe window top most on the desktop. When this item is checked the Screen 
Loupe window will float above all other non-topmost windows on the desktop. This item is useful if you normally run Screen 
Loupe with a small window that would be easily obscured by other applications. The Ctrl+T shortcut can be used for this 
command.

Tip Commonly used View commands can be invoked using shortcut keys.



Tools Menu
Tools Menu Commands
The Tools menu provides commands used to open and display Screen Loupe tool windows. A short description of each item 
follows:

Horizontal Ruler
Opens the Horizontal Ruler window. The Ctrl+R shortcut can be used for this command.

Vertical Ruler
Opens the Vertical Ruler window. The Ctrl+L shortcut can be used for this command.

ASCII Chart
Opens the ASCII Chart window. The Ctrl+A shortcut can be used for this command.

Error Codes
Opens the Error Codeswindow. The Ctrl+E shortcut can be used for this command.

System Information
Opens the System Information window. The Ctrl+S shortcut can be used for this command.

Help
Opens the Screen Loupe Help window and displays the Table of Contents. The F1 shortcut can be used for this command.

Setup
Displays the Screen Loupe Setup dialog box. This window provides options to integrate Screen Loupe with the MS 
Windows Explorer. Use this window to create MS Explorer Start Menu items and desktop icons.

About Loupe
Displays the Screen Loupe splash box. This window contains program information, the current version of Screen Loupe 
you are running and a program copyright notice. Click the mouse anywhere in this window to close it

Tip Commonly used Help commands can be invoked using shortcut keys.



Shortcut Keys
Shortcuts
Shortcut keys allow you to quickly invoke Screen Loupe menu commands without first displaying the menu and then selecting 
an item from it. The most commonly used Screen Loupe commands can be invoked using the following shortcut keys.

File Menu
Ctrl+Q Exit Screen Loupe, and return to the desktop

Edit Menu
Ctrl+C Copy the current view

View Menu
Ctrl+1 Set magnification rate to 1:1
Ctrl+2 Set magnification rate to 2:1
Ctrl+4 Set magnification rate to 4:1
Ctrl+8 Set magnification rate to 8:1

Ctrl+K Toggle locked viewing
Ctrl+F Toggle fixed viewing

Ctrl+Y Minimize Screen Loupe to a button or icon
Ctrl+T Make the Screen Loupe window topmost

Tools Menu
Ctrl+R Open the Horizontal Ruler window
Ctrl+L Open the Vertical Ruler window

Ctrl+A Open the ASCII Chart window
Ctrl+E Open the Error Codes window
Ctrl+S Open the System Information window

F1 Display this Help file



Copying the Current View
Copying the Current View
You can copy the current contents of the Loupe window to the clipboard using Ctrl+C, (using the Copy item on the Edit menu will
simply copy the menu itself).

To copy a portion of the screen; make Loupe the active window, place the mouse over the area to be copied and press Ctrl+C to
copy the Loupe display at the current magnification rate to the clipboard.

Once an image has been placed on the Clipboard it can be easily transfer into another application that allows graphics imaged 
to be pasted into documents.



Locking the Current View
Locking the Current View
You can lock the image currently displayed in the Loupe window using Ctrl+K.

This command, like the copy command needs to be carried out from the keyboard, or you will wind up with a locked view of the 
menu itself.

Press Ctrl+K again to turn off view locking and return to normal viewing.



Viewing a Fixed Region
Viewing a Fixed Region
Screen Loupe can be used to view a fixed region of the display instead of tracking the mouse as it moves.

To use the Fixed View option make Screen Loupe the active window, move the mouse to the location on the display to be used 
as the viewing area and press Ctrl+F.

To restore Screen Loupe to normal mouse tracking press Ctrl+F again.

Note After resizing the Screen Loupe viewing window you will need to turn Fixed Viewing on again.



Horizontal Ruler
Horizontal Ruler
Select the Tools | Horizontal Ruler menu item to open and display a small horizontal pixel ruler. You can also use the Ctrl+R 
shortcut to display this window.

The length of this window can be adjusted to accommodate your current screen size. Use this window to make accurate 
measurements of items on the desktop.

Tip Increase Screen Loupe’s viewing magnification to make it easier to read the horizontal ruler graticule.



Vertical Ruler
Vertical Ruler
Select the Tools | Vertical Ruler menu item to open and display a small vertical pixel ruler. You can also use the Ctrl+L shortcut
to display this window.

The height of this window can be adjusted to accommodate your current screen size. Use this window to make accurate 
measurements of items on the desktop.

Tip Increase Screen Loupe’s viewing magnification to make it easier to read the vertical ruler graticule.



ASCII Chart
ASCII Chart
Select the Tools | ASCII Chart menu item to open and display a window containing the ASCII / ANSI character set. You can also
use the Ctrl+A shortcut to display this window.

Displaying Character Codes
Click the left mouse button on a character in this chart to display its ASCII code in decimal, octal and hexadecimal.

Copying Special Characters
Click the right mouse button on a character in this chart to copy the selected character to the Clipboard. This command is useful 
if you want to copy characters that do not appear on a normal keyboard. From the Clipboard these characters can easily be 
copied into other text editing programs.



Error Codes
MS Windows 95/NT Error Codes
Select the Tools | Error Codes menu item to display a list of all Microsoft Windows 95/NT errors codes and their descriptions. 
You can also use the Ctrl+E shortcut to display this window.

When this item is selected Screen Loupe for Windows 95/NT will query the operating system and build a list of all error codes 
defined for the operating system. This list will contain the actual error code numbers as well as a short description of what each 
error code means. This list may be useful if you have other programs that produce error code warnings, but do not include an 
explanation of what the actual error means.

Error codes will be displayed in a list that contains both the decimal error code number as well as the hexadecimal value of the 
error.



System Information
System Information
To activate the System Information window select the Tools | Information menu choice or press the Ctrl+S shortcut key. A small
window will be opened and displayed on the desktop showing the current system configuration and resource usage.

This window is dynamically updated as system resources change. The following items are reported:

Microsoft Windows
This region displays the version of MS Windows installed on your computer and the type of CPU found. If you are using a 
system that has more than one processor installed this will also be reported here.

Memory
This region displays the total amount of RAM available to Windows as well as the amount of memory that is currently free. MS 
Windows 95 cannot use the lower 640K of memory used by MS DOS so the total RAM available will be slightly less than the 
total RAM installed on your system. The free memory value will change dynamically as programs are loaded, run and unloaded.

Note MS Windows 95/NT systems use virtual memory, so as physical memory is exhausted virtual memory is created. Watch 
the Swap gauge in the Resources section to monitor virtual memory allocation.

Video Monitor
This region displays the current video display resolution and the number of colors available as follows:

1-bit: black & white (monochrome)
4-bit: 16 colors or shades of gray
8-bit: 256 colors or shades of gray
16-bit: Thousands of colors
32-bit: Millions of colors

Resources
This region displays three gauges showing the current resource usage for the System, RAM and Swap space. These items will 
change as programs are loaded, used and unloaded. The color of the gauge changes based upon the current usage as follows:

Blue: less than 90% usage
Yellow: less than 95% used
Red: more than 95% used

Note If you are having trouble loading a program check these values as you attempt to launch the application.



Command Line Arguments
Command Line Arguments
Screen Loupe for Windows 95/NT can be invoked using command line parameters. If command line parameters are detected at 
launch time Screen Loupe will use those settings detected.

LOUPE [/1|/2|/4|/8] [/slow|/normal|/fast] [/sound|/nosound] [/splash|/nosplash]

/1 1:1 magnification rate
/2 2:1 magnification rate
/4 4:1 magnification rate
/8 8:1 magnification rate

/slow Slow refresh rate
/normal Normal refresh rate
/fast Fast refresh rate

/sound Play shutter sound when copying
/nosound Silent copying

/splash Show splash box at startup
/nosplash Hide splash box at startup



Release History
Screen Loupe for Windows 95/NT Release History

v2.0 Original in-house development and testing of MS Windows 95/NT conversion using the Microsoft Win32 SDK.

v2.1 Added 95/NT splash box for release.

v2.2 Added a crosshair display option and a menu item to hide or show the mouse coordinates.    MS Windows 95/NT error 
codes are now loaded directly from the operating system. Rulers can now be resized. The ASCII chart includes the octal 
character code in the popup. 

v2.3 Added selections to the Options dialog to specify topmost window Z ordering for the System Information and Error Code 
Windows.

v2.4 Added window resizing for the main view.

v2.5 Added a viewing lock toggle using Ctrl+K. Added an option to allow multiple instances to be run on the desktop and SLR 
camera shutter sound for clipboard captures.

v2.6 Added an option to place the Loupe icon in the Taskbar tray.

v2.7 Added options to display mouse position and magnification controls at the bottom of the main viewing window.

v2.8 Added Fixed View and Minimize items to the View menu.

v2.9 Added RGB color triplet reporting.

v3.0 Added an option to select HTML color triplet display or normal Hexadecimal RGB code.

v3.1 Added support for screen color settings as specified in the Display Properties dialog. Added default user and company 
name to the splash box.

v3.2 Added MS Windows 95/NT Help file. Fixed a bug that prevented proper window positioning when the MS Explorer 
Taskbar was placed at the top or left edge of the display. Added automated setup facilities to create shortcut links.

v3.3 Fixed a bug that prevented the proper display of RGB triplets when the mouse pointer was moved to the edge of the 
desktop. Converted the Screen Loupe Options dialog box to a three-tab property sheet. Added a command line option to 
turn off the opening splash box.

v3.4 Fixed a bug that prevented proper window relocation when the MS Explorer Taskbar was placed along the left edge or at
the top of the desktop and the Auto Hide option was active. Fixed several other minor bugs.

Last Update    December 13th, 1997



System Registry
Screen Loupe for Windows 95/NT System Registry Key

Screen Loupe for Windows 95/NT stores configuration settings in the MS Windows 95/NT System Registry. These settings are 
updated automatically while Screen Loupe is running. There is no need to edit these settings manually.

If you insist upon editing these settings, you do so at your own risk. Screen Loupe automatically updates registry entries when it 
exits. If you edit these settings make sure Screen Loupe is not running while you edit them. If Screen Loupe is currently running 
your changes will be overwritten when Screen Loupe exits.

Screen Loupe for Windows 95/NT stores configuration settings in the following system registry key:

HKEY_CURRENT_USER
Software

Software by Design
Screen Loupe for Windows 95/NT

Section
Label = Value

Warning There is no need to edit these settings manually. Screen Loupe will automatically maintain these settings for you. If you
do edit these, you do so at your own risk.



Removing Screen Loupe
Removing Screen Loupe for Windows 95/NT from Your Computer
If you find that Screen Loupe for Windows 95/NT does not meet your needs you can remove it from your computer system by 
simply deleting the following files from your hard drive. All of these files will be located in the folder that you originally installed 
Screen Loupe in.

Loupe.exe Screen Loupe for Windows 95/NT application program.
Loupe.cnt Screen Loupe Help Topics File
Loupe.hlp Screen Loupe Help File

If you have opened and used the Screen Loupe for Windows 95/NT Help files your system may contain the following two (2) 
files. These files are created by the standard MS Windows 95/NT Help program WinHlp32.exe. These files may also be safely 
removed.

Loupe.gid MS Windows Help settings file. This file contains the Screen Loupe Help window size and desktop location 
as well as any bookmarks you may have created.

Loupe.fts MS Windows Help word database. This file is created when you build a custom word list for Screen Loupe 
Help files. This files is used to search for words and phrases in the Screen Loupe Help files.

Screen Loupe for Windows 95/NT does not use any custom DLL files or system drivers. If you delete the files mentioned above 
from your system’s hard drive you will have completely removed Screen Loupe from your computer system.

Note If you have installed Screen Loupe shortcuts on the MS Explorer Start Menu use the Help | Setup command to remove 
the shortcuts you created before you delete the Screen Loupe files mentioned above.




